
EVM User's Guide: INA700-701EVM
INA700-701EVM 评估模块

说明

INA700-701EVM 是一个易于使用的平台，可用于评估 

INA700 或 INA701 器件的主要特性和性能。该评估模

块 (EVM) 附带图形用户界面 (GUI) 支持，用于器件寄

存器的读取和写入操作。

开始使用

1. 购买 INA700 或 INA701 评估模块。

2. 购买 TI-SCB 传感器控制板 (SCB)。
3. 下载并安装 PAMB Windows USB 驱动程序。

4. 阅读本用户指南以设置硬件。

5. 运行 EZShunt-EVM-GUI。

特性

• GUI 支持读取和写入器件寄存器以及查看和保存结

果数据
• 从 SCB 分离的 EVM，适用于定制用例

• 单个 SCB 或 GUI 支持多个 EVM
• 借助 SCB 方便地通过常见的 micro-USB 连接器充

电
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1 评估模块概述

1.1 简介

此 EVM 是一个易于使用的平台，用于评估 INA700 或 INA701 的主要特性和性能。EVM 包含图形用户界面 

(GUI)，用于读取和写入器件寄存器以及查看和保存结果数据。有关所需用例的电流限制，请参阅各个器件的数据

表。

本用户指南介绍了 INA700 和 INA701 评估模块 (EVM) 的特性、操作和使用情况。这些 EVM 用于评估 INA700 和 

INA701 的性能。本文档中的评估板、评估模块和 EVM 等所有术语均指 INA700-701EVM。本文档包括原理图、

参考印刷电路板 (PCB) 布局和完整的物料清单 (BOM)。

1.2 套件内容

表 1-1 列出了 EVM 套件的内含物。如果缺少任何元件，请与德州仪器 (TI) 客户支持中心联系。

表 1-1. 套件内容

项目 数量

INA700EVM 或 INA701EVM 1

备注
该 EVM 需要使用单独售卖的 TI 传感器控制板 (SCB)，可在此处找到。

1.3 规格

此 EVM 旨在对该器件的基本功能进行评估，此布局并非作为目标电路的模型使用，也不针对电磁兼容性 (EMC) 
测试进行布局。此 EVM 包含一块印刷电路板 (PCB)。这块 PCB 叫做 EVM，安装了 INA700 或 INA701。

1.4 器件信息

INA700 和 INA701 是数字电源监控器，具有集成分流电阻器和专为电流检测应用而设计的 16 位 Δ-Σ ADC。这

两款器件可以测量高达 ±15.728A (INA700) 或 ±6.225 A (INA701) 的满量程电流，共模电压范围为 –0.3V 至 

+40V。

INA700 和 INA701 报告电流、总线电压、芯片温度、功率、能量和电荷累积，并采用精度为 ±0.5% 的集成振荡

器，同时在后台执行所需的计算。集成式温度传感器在结温范围内精度为 ±3°C。

INA700 和 INA701 具有低温漂和增益误差漂移，因此可用于在制造过程中不进行温度校准的系统。

该器件支持选择从 50µs 到 4.12ms 的 ADC 转换时间以及从 1x 到 1024x 的采样平均值，这有助于进一步降低测

量数据的噪声并能够优化过流检测窗口。

该器件采用微型 PowerWCSP (DSBGA) 封装，可更大限度地减小解决方案尺寸并提高热性能。

表 1-2. 器件概要

产品 数字协议 ADC 分辨率 最大增益误差 最大失调电流

INA700 I2C 16 位 ±0.5%
（5A 时）

±1.5mA

INA701 I2C 16 位 ±0.5%
（0.5A 时）

±0.5mA

2 硬件

2.1 快速入门设置

以下说明介绍了如何设置和使用 EVM。

1. 如果您没有 SCB，请购买一个。

a. 若要改用 PAMB 控制器，请参阅 PAMB 兼容性。
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2. 下载此驱动程序并以管理员身份安装：https://www.ti.com/cn/lit/zip/sbac253。
a. 按照下载提示操作；并且需要具有 myTI 账户。

b. 请注意，虽然此驱动程序标记为 PAMB 驱动程序，但也用于 SCB。

3. 如图 2-1 所示，将 EVM 连接到 SCB 控制器。

a. 连接相同类型的多个 EVM 时，请参阅图 2-2。

4. 使用提供的 USB 电缆将 EVM 连接到 PC。

a. 将 micro-USB 电缆插入到 SCB 控制器板载 USB 插座 J2 中。

b. 将该电缆的另一端插入 PC。

5. 在 Chrome®、Firefox ® 或 Safari® 浏览器中通过以下链接访问 GUI：https://dev.ti.com/gallery/info/
CurrentSensing/EZShunt-EVM-GUI。

6. 将外部系统的 GND 基准连接到 EVM 的 GND 节点（J1 的引脚 1 或 2）。

7. 验证已禁用负载电流，然后通过将信号引线连接到 EVM 上的 J1 引脚 5 或 6 和 J1 引脚 3 或 4，将 IN+ 和 

IN– 引脚置于负载线路上（请参阅 电流检测工作原理）。

2.2 EVM 操作

若要将 EVM 和 SCB 控制器（单独销售）搭配使用，如图 2-1 所示连接 EVM。

图 2-1. EVM（左）连接到 SCB 控制器（右）

如果使用多个 EVM，如图 2-2 所示进行连接。确保对每个器件使用不同的地址。GUI 一次仅支持一个 EVM 和器

件类型；总共最多四个 EVM。

图 2-2. 多个 EVM 连接到 SCB 控制器

2.2.1 电流检测工作原理

INA700 和 INA701 都配备了内部分流电阻器，并且开箱即可用于测量电流（有关所需用例的电流限制，请参阅各

个器件的数据表）。为了方便起见，IN-（J1 引脚 5 和 6）和 IN+（J1 引脚 3 和 4）各有两个端子。
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2.2.1.1 详细设置

若要配置测量评估，请按以下步骤操作：
1. 连接载流线路：在断电状态下将线路输入连接到 IN+ 端子，并将结果输出线路连接到与负载串联的 IN– 端

子。

警告

测量电流时，首先验证设备（分流电阻器、导线、连接器等）可以承受相应的电流和功耗。其次，根

据具体用例，验证流经 J1 的电流是否不超过所用器件的电流限制。否则可能会导致 EVM 损坏或人身

伤害。

EVM 可能变热。

2. 将系统接地端连接到端子 J1（引脚 1 或 2）上的任一 GND 终端。

3. 给系统上电，然后通过 GUI 观察器件状态和输出。
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2.3 电路

本节总结了 EVM 子系统及元件。

2.3.1 电流检测 IC

本节介绍了主要的器件和配套元件。

U1 是主要的电流检测器件（INA700 或 INA701）。C1 和 C2 是旁路电容器，放置在传感器附近，有助于降低电

源噪声并在需要时快速为器件提供电流。具有限流电阻器 R4 的 LED D1 用于指示 EVM 何时通电。

2.3.2 输入信号路径

本节介绍了输入信号路径的电路。

J1 是主连接端子。J1 的引脚 1 和 2 用于将系统接地端连接到 EVM 接地端。引脚 3、4 连接到 IN+，引脚 5、6 连
接到 IN–。为了方便起见，各有两个引脚用于 IN– 和 IN+ 以及电流能力。对于大于 10A 的电流，请验证端子块

的所有引脚都已填充。

2.3.3 数字电路

本节介绍了器件的数字电路。

J2 和 J3 是将数字引脚和电源引脚连接到 SCB 控制器或其他 EVM 的主要接头引脚。J3 连接到右侧的 EVM 或 

SCB，而 J2 连接到左侧更多的 EVM。R5 和 R6 用作 SDA 和 SCL 引脚的上拉电阻器。

SW0 用于设置器件的 I2C 地址。当使用 EVM 与自定义控制器（非 SCB 控制器）或连接多个 EVM 时，这种做法

很有用。当前 SCB 控制器和 GUI 设置为一次使用最多四个 EVM。

R8 用作 ALERT 引脚的上拉电阻器。LED D2 和限流电阻器 R7 用于指示 ALERT 何时触发。U2 是一个开漏缓冲

器，可将警报信号转发到 J2 和 J3，而不允许信号从 ALERT 总线传播到器件。该功能主要在使用多个 EVM 时使

用，以便在仍使用 ALERT 总线的情况下可以在每个 EVM 上看到单独的 ALERT LED。R9 是 ALERT 总线的上拉

电阻器。C3 是一个旁路电容器，放置在缓冲器附近，用于降低电源噪声并帮助在需要时快速为器件提供电流。

当将多个 EVM 连接在一起时，可能需要移除一些 EVM 的 I2C 总线和 ALERT 总线的上拉电阻器，以避免上拉过

强。

2.4 PAMB 兼容性

如有需要，通过使用跳线将 PAMB 的引脚接头连接到 EVM，此 EVM 和 GUI 可以与 PAMB 控制器 (DC081A) 搭
配使用。图 2-3 显示了 PAMB 上与 EVM 接头引脚相对应的引脚。请注意不要在跳线连接设置中添加过大电阻，
否则信号可能出现性能下降并会导致通信错误。

图 2-3. EVM 至 PAMB 连接
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3 软件

3.1 设置

3.1.1 驱动程序安装

下载并安装此驱动程序：https://www.ti.com/lit/zip/sbac253。每台计算机只需执行一次该步骤，并且需要 myTI 账
户。请注意，此驱动程序标记为 PAMB 驱动程序，但也用于 SCB。解压文件夹并以管理员权限运行 .exe 文件。

3.1.2 固件

固件更新通过 GUI 推送（需要安装以前的驱动程序）。下载的离线 GUI 只能用下载时可用的最新固件更新 SCB 
控制器。若要查看是否有最新的 GUI 或固件更新，请从网络浏览器启动最新版 GUI。

3.1.2.1 固件调试

如果由于任何原因必须手动重新安装固件，请按照以下步骤重新安装固件。确保在通电之前将 EVM 连接到 

SCB。

1. 首先，查看 GUI 是否可对固件手动编程。

a. 将 SCB 控制器插入 PC。

i. 首先确保将 EVM 连接到 SCB。

b. 启动 GUI 并关闭 READEME.md 窗口。

c. 如果 MCU 已经处于器件固件升级 (DFU) 模式，则会出现一个对话框，显示“Connection Failure - No 
SCB controller detected”。关闭此窗口。

i. 对于新的 SCB，LED 循环 4 次，然后自动进入 DFU 模式。

d. 如果 GUI 没有自动更新，请转到 File > Program Device...。
i. 如果 Program Device... 按钮仍显示为灰色，则点击左下角的“Connect”按钮，然后重试。

2. 如果第 1 步失败（或者 Program Device 按钮仍然灰显），则手动将 SCB 控制器上的 MCU 配置为 DFU 模
式。在 SCB 控制器通电的情况下，可通过以下任一方法完成此操作：
a. 通过软件：

• 在 SCB 的 USB 串行 (COM) 端口上发送命令“bsl”。

b. 通过硬件：
• 出于安全起见，关闭并断开所有负载源和外部电压。

• 使用一对镊子（或导线）短接标记为 DFU（如图 3-1 所示）的两个测试点时，按下并松开 RESET 按
钮。
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图 3-1. 用于手动进入 DFU 模式的测试点

• 如果改用 PAMB 板，那么这些测试点位于 PK1 和 PK2 附近。

MCU 进入 DFU 模式后，通过步骤 1 中列出的方法上传固件。如果器件处于 DFU 模式，但固件更新仍然失败，
则手动将驱动程序 ("boot_usb.inf") 与 DFU 器件关联。

3.1.3 GUI 设置和连接

您可以在 Chrome®、Firefox® 或 Safari® 浏览器中通过以下链接访问 GUI：https://dev.ti.com/gallery/info/
CurrentSensing/EZShunt-EVM-GUI。

3.1.3.1 初始设置

首次设置 GUI：

1. 确保前面提到的驱动程序成功安装，以使一切正常工作，并且 GUI 可以在必要时更新 EVM 固件。

2. 检查以确保 EVM 和 SCB 控制器单元已插入 PC，然后转到前面提供的 GUI 链接。

a. 在将 SCB 插入 USB 端口之前，请验证 EVM 已连接到 SCB。

3. 点击 GUI Composer 应用程序，以从网络浏览器启动 GUI（请参阅 图 3-2）。
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图 3-2. GUI Composer 应用程序

a. GUI 链接会打开所有版本的 GUI。TI 建议启用最新的可用版本。

b. 首次设置 GUI Composer 时，请根据提示下载 TI Cloud Agent 和浏览器扩展（请参阅图 3-3）。关闭 

README.md 对话框以查看这些提示。

图 3-3. TI Cloud Agent
4. （可选）要下载 GUI 以供离线使用，请点击 GUI Composer 应用程序中的  图标，然后按照提示操作（请

参阅 图 3-2）。
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3.1.3.2 GUI 至 EVM 连接

若要将 GUI 连接至 EVM，请按照以下步骤操作：

1. 按照 初始设置 所述设置和启动 GUI。
a. 在上电之前将 EVM 连接到 SCB。

2. 关闭 README.md 文件页面以启动 EVM 和 GUI 之间的连接。如果连接成功，GUI 左下角附近会显示 

Hardware Connected 消息。

图 3-4. 硬件已连接

a. GUI 的左上角附近应该还会显示一个绿色指示器以及器件类型和文本 DEVICE CONNECTED。

图 3-5. 器件已连接

b. 如果 GUI 中未显示 Hardware Connected 和 DEVICE CONNECTED，请长按 EVM 上的 RESET 按钮进

行重试。

i. 如果长按重置按钮不起作用，则检查 Options > Serial Port 下的其他硬件 COM 端口。

图 3-6. 更改串行端口

c. 如果硬件仍然没有连接，则确保使用的 GUI 和 EVM 组合正确无误。

i. 如果使用的 GUI 和 EVM 组合正确，则对 SCB 固件重新编程，如 固件调试 所述。

ii. 很多连接问题都可以通过以下其中一个方法得到解决：
1. 在 EVM 与 SCB 彼此连接的情况下，长按 EVM 上的 RESET 按钮。

• 刷新 GUI 也有帮助。

2. 将 EVM 连接到其他 USB 端口。

• 避免使用长电缆和 USB 集线器。

• 如果使用的是台式 PC，可尝试使用机箱背面的 USB 端口。

3.2 GUI 操作

根据 GUI 设置和连接，设置和启动 GUI 并将其连接至 EVM。有关如何使用每个 GUI 选项卡的说明，请参阅以下

几节。
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3.2.1 主页选项卡

GUI 启动后首先显示主页选项卡。点击左侧菜单上的 （主页）图标，可随时返回主页选项卡。

您可以轻松地从主页确认 GUI 到 EVM 的连接成功（请参阅 GUI 至 EVM 连接）。通过底部的按钮也可以获得一

些有用的资源（请参阅 主页选项卡链接）。

图 3-7. 主页选项卡链接

3.2.2 Registers 选项卡

若要查看和编辑器件寄存器，请点击左侧菜单上的 （寄存器）图标。寄存器 选项卡将如 图 3-8 所示。

图 3-8. GUI 寄存器选项卡

通过此选项卡，用户可以在 EVM 上读取和写入器件寄存器。这里列出了一些重要注意事项：

• 在 Register 选项卡上，使用顶部的 Selected EVM 下拉菜单来选择要使用的器件。

– 此按钮的功能是，在 MCU 中设置默认读取和写入地址，然后读回所有寄存器值，以更新寄存器映射。注

意，如果当前数据采集频率高，可能会导致数据采集略有延迟。为防止这个问题，在开始采集数据前，请先

设定器件设置。
• 默认情况下，所有更改都会自动写入器件。如果需要，用户可以将 Immediate Write 设置更改为 Deferred 

Write，以便仅在就绪后允许写入。

– 用户可以通过以下任一方法修改可写寄存器值：
• 通过右侧 Field View 部分中的小工具设置。

• 使用十六进制或十进制值直接更改 Value 字段。

• 双击任何单个的位。
• 打开 Auto Read 只会更新 Registers 选项卡中的寄存器，而不会更新 Results Data 部分中的图形。
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– 如果在收集数据期间使 Auto Read 处于打开状态，可能会干扰数据收集时序。

• 如果对寄存器或寄存器位字段有任何问题，请点击  图标。

– 如果对寄存器还有更多疑问，请查看数据表。

• 为了方便起见，可以将寄存器设置保存起来，之后再载入任何具有相同寄存器映射的器件。要保存或重新加载

寄存器设置，请转到 File > Register Data。

图 3-9. 保存和加载寄存器设置

– 在加载数据后按下 Read All Registers 按钮，以使用实际器件值更新寄存器映射，以防加载的寄存器与连接

的器件不兼容。

3.2.3 结果数据选项卡

要查看和收集一段时间内的结果数据，请点击左侧菜单上的 （结果数据）图标。图 3-10 显示了结果数据页面

的一部分以供参考，根据连接的 EVM 的数量，该页面可能看起来有所不同。
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图 3-10. Results Data 选项卡和设置

下面介绍了如何使用 Results Data 选项卡顶部和每个图表旁边的按钮和设置：

• Results to collect/show
– 使用此部分选择要为其收集数据的寄存器值。如果在按下 COLLECT DATA 按钮之前未选择结果寄存器，则

下面的图表将隐藏，EVM 在采集周期中不会试图读取此寄存器（即使启用了转换）。

– 如果用户在 EVM 采集数据时禁用其中一个设置，那么图表不会显示，但仍然会采集数据，而图表将在后台

更新。重新选择可显示数据。
• Number of EVMs

– 将 Number of EVMs 下拉菜单设置为当前在用的 EVM 数量。

• 请参阅图 2-2，了解如何将多个 EVM 连接起来。

– GUI 一次仅支持一个 EVM 和器件类型，总共最多四个 EVM。

– Switch settings
• 使用板载开关为每个 EVM 选择不同的地址。

• 在 GUI 中设置开关设置，以便与每个连接的 EVM 的设置保持一致。

– 如果在连接 EVM 的情况下为 SCB 供电，则 EVM 1 会自动填充地址最低的器件，除非已经选择某个

设置。
• 如果使用多个器件，则 Registers 选项卡上所用的已选 EVM 旁会显示星号 (*)。

– 更改任意 EVM 的开关设置时，会将相应的 EVM 设为所选的 EVM。

• 收集和图表设置

– Collect Data
• 按下 COLLECT DATA 按钮开始采集数据。
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• 在此模式下，MCU 通过 USB BULK 通道读取和发送为每个器件选定的结果值。读取一个器件的所有结

果后，再继续读取下一个器件。

– 所有 EVM 的所有结果值共同视为一个“样本集”。

• 虽然在采集数据时，用户可以通过 Registers 选项卡对其他寄存器进行读写，但这会增加数据采集的延

迟时间。
• 按 STOP COLLECT 按钮停止采集数据。

– #Samples Only
• 如果选中了此复选框，GUI 会在采集的样本数量达到“#Samples”框中指定的数量后，自动停止采集数

据。
• 如果未选中该复选框，GUI 继续采集数据并仅存储最新的 #Samples 个样本。

– Delay between samples
• 设置每个样本集的开始时间之间的延迟。
• 如果延迟时间短于读取循环（取决于要采集的结果数量、EVM 数量以及 CPU），则无法获得所需的延

迟时间。
• 虽然在采集数据时，用户可以通过 Registers 选项卡对其他寄存器进行读写，但这会增加数据采集的延

迟时间。
– Auto Delay

• 根据转换时间、平均值和要转换的通道数量，设置延迟。

• 如果使用多个 EVM，则延迟框中输入的时间来自于计算所得延迟值最小的 EVM。

– Save All Plots
• 按下 SAVE ALL PLOTS 按钮可以将 Results to collect/show 部分中每个当前已选结果对应的数据保存到

电子表格中。
• 按下每个图表旁边的 SAVE PLOT 按钮，可仅将该图表中的数据保存在电子表格中。

– Clear All Plots
• 按下 CLEAR ALL PLOTS 按钮可清除所有图表中的数据。

• 按下每个图表旁边的 CLEAR PLOT 按钮可仅清除该图表中的数据。

– #Samples
• 更改此框中的数值可更改每个图表中显示的样本数。

– 更改此数值会清空图表缓存，以便在下次读取时清除图表。

– Y-Axis Options
• Manual Scale

– 选中此复选框会将此图表中的所有 EVM 结果设为“Max”和“Min”字段中指定的相同标度值。

– 如果未选中此复选框，每个 EVM 都将具有单独的 Y 轴标度，具体取决于这些 EVM 结果值的最小值

和最大值。
– 对于 DIETEMP 结果，单位可以在 °C 和 °F 之间切换。

• 系统会处理图表中的现有数据，并转换输入的新数据。如果在更改单位期间收到新的数据，则数

据点可能丢失或出现重复。
• 最大值

– 此图表中用于所有 EVM 的最大 Y 轴值。

– 选中 Manual Scale 后，如果此字段为空白，则字段自动填充相应图表中当前的最大值。

• 最小值

– 此图表中用于所有 EVM 的最小 Y 轴值。

– 选中 Manual Scale 后，如果此字段为空白，则字段自动填充相应图表中当前的最小值。

3.3 EVM USB 直接通信

如有需要，可不使用 GUI，通过 USB 端口直接与 EVM 进行通信。具体方式是，通过串行 COM 端口发送所需的

命令字符串，并根据模式通过 COM 端口或 USB BULK 通道接收结果。这有助于通过自定义设置、脚本或 GUI 连
接 EVM。

3.3.1 标准 USB 读写操作

使用串行 COM 端口通过以下格式的 USB 命令读写寄存器：
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• 设置器件地址格式：setdevice DEVID
– 其中 setdevice 始终为小写，并且 DEVID 定义为：

• 地址的四个最低有效位，采用十进制格式。例如，0x4A 的地址是 10。
– 请注意，如果在连接了一个或多个 EVM 时复位 SCB，地址将默认为找到的最低地址。

• SCB 会在启动时检查是否存在 I2C 或 SPI。如果未连接任何器件，则 SCB 默认为 SPI。应在连接了 I2C 
EVM 的情况下重置 SCB 以使用 I2C。

– 例如，若要设置寄存器地址为 0x4A 的 I2C EVM，可以发送命令：setdevice 10
– 对于本例，EVM 会返回 JSON 格式的确认和状态（“idle”或“collecting”）：

{"acknowledge":"setdevice 10"}
{"evm_state":"idle"}

• 读取寄存器格式：rreg ADR
– 其中 ADR 是十六进制地址，rreg 始终为小写。

– 寄存器地址可以是大写或小写，并且不需要以“0x”开头。也可以选择用 0 来填补寄存器地址。例如，若

要读取寄存器地址 0xB，一些有效的命令可包括：
• rreg b
• rreg 0B
• rreg 0x0B

– 使用“0x”时，“x”必须为小写。

– 对于本例，EVM 会返回 JSON 格式的结果和状态（“idle”或“collecting”）：
{"acknowledge":"rreg 0x0B"}
{"register":{"address":11,"value":3}}
{"evm_state":"idle"}

• 写入寄存器格式：wreg ADR VAL
– 其中 ADR 和 VAL 采用十六进制，wreg 始终为小写。

– 寄存器地址和值可以是大写或小写，并且不需要以“0x”开头。也可以选择用 0 来填补寄存器地址和值。

例如，要向寄存器地址 0x1 写入值 0xfb68，某些有效的命令包括：
• wreg 1 fb68
• wreg 01 0xfb68
• wreg 0x01 0xFB68

– 使用“0x”时，“x”必须为小写。

– 对于本例，EVM 会返回 JSON 格式的结果和状态（“idle”或“collecting”）：
{"acknowledge":"wreg 0x01 0xfb68"}
{"console":"Writing 0xfb68 to ADC_CONFIG register"}
{"evm_state":"idle"}

3.3.2 通过 USB BULK 通道采集数据

“Collect Data”功能会根据指定的设置，读取所需的结果寄存器并发送相关数据。此功能在连续转换模式下性能

最佳，但不能配置 EVM 或相关的寄存器设置。收集模式通过串行 COM 端口启动和停止，但通过 USB BULK 通
道发送结果。若要使用此模式，请使用以下格式：

• 启动数据采集的格式：collect timerPeriod collectFlags channelAddressIDs numDevices
– 收集始终以小写形式完成，并且每个参数均以十进制表示值，格式如下：

• timerPeriod
– MCU 中用于数据采集样本集的时间延迟（单位为毫秒，无符号 32 位值）。

• collectFlags
– 根据以下定义，一个数据字节具有 1（表示要收集每个寄存器值类型）和 0（表示不收集每个寄存器

值类型）：
• VBUS = 0b0100000
• DIETEMP = 0b0010000
• CURRENT = 0b0001000
• POWER = 0b0000100
• ENERGY = 0b0000010
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• CHARGE = 0b0000001
• channelAddressIDs

– 这是以位 3-0 开头的每个 I2C 地址串连起来的 4 个最低有效位。

• 例如，如果 EVM 1 在通道 0x44 上，EVM 2 在通道 0x46 上，这里的值就是 0b01100100。
• NumDevices

– 串连起来的 EVM 数量 (1-4)。
– 例如，要每 3.156ms 开始进行一次 VBUS 和 DIETEMP 数据采集，则对于 EVM 1 地址 = 0x44 和 EVM 2 

地址 = 0x46 的两个 INA700，需要发送：collect 3156 48 100 2。
• 对于本例，EVM 会返回 JSON 格式的确认和状态：

{"acknowledge":"collect 3156 48 100 2"}
{"evm_state":"collecting"}

– USB BULK 通道接收如下格式的数据：frameID deviceNumID address registerSize data。
• 每个参数以十进制表示值，格式如下：

– frameID（1 个字节）
• 始终读为 0。用于验证数据已对齐。

– deviceNumID（1 个字节）
• 对应于 EVM 编号的 ID 数字：

– 在上面的示例中，如果从地址设置为 0x44 的 EVM 1 读取，该值为 1，如果从地址设置为 

0x46 的 EVM 2 读取，该值为 2。
– address（1 个字节）

• 从器件读取的寄存器地址。
– registerSize（1 个字节）

• 后面数据的字节数。
– data（一次 1 个字节）

• 字节形式的寄存器数据值，首先是最高有效字节 (MSB)。
• 停止数据采集的格式：stop

– 其中 stop 始终为小写。

– EVM 返回 JSON 格式的确认和状态：
{"acknowledge":"stop"}
{"evm_state":"idle"}
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4 硬件设计文件

4.1 原理图

图 4-1 至图 4-2 显示了 EVM 的原理图。图 4-1 显示了 EVM 的电路。图 4-2 显示了 EVM 随附的机械部件。
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图 4-1. SENS113 原理图
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LOGO
PCB

Texas Instruments

FID2FID1 FID3

SENS113

B

PCB Number:

PCB Rev:

Label Assembly Note
ZZ1

This Assembly Note is for PCB labels only

Assembly Note
ZZ2

These assemblies are ESD sensi�ve, ESD precau�ons shall be observed.

Assembly Note
ZZ3

These assemblies must be clean and free from �ux and all contaminants. Use of no clean �ux is not acceptable.

Assembly Note
ZZ4

These assemblies must comply with workmanship standards IPC-A-610 Class 2, unless otherwise speci�ed.

CE Mark

LOGO
PCB

FCC disclaimer

LOGO
PCB

WEEE logo

CAUTION HOT SURFACE

H2

SJ5382

H3

SJ5382

H1

SJ5382

H4

SJ5382

Variant/Label Table

Variant Label Text

001 INA700EVM

002 INA701EVM

Size: 0.65" x 0.20 "

PCB Label

LBL1

THT-14-423-10

图 4-2. SENS113 硬件原理图
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4.2 PCB 布局

备注

电路板布局布线未按比例显示。这些图旨在显示电路板的布局。而不用于制造 EVM PCB。

图 4-3 至图 4-6 描绘了 EVM 的 PCB 层。

图 4-3. SENS113 顶视图 图 4-4. SENS113 顶层

图 4-5. SENS113 底视图 图 4-6. SENS113 底层
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4.3 物料清单

表 4-1 提供了 EVM 的器件列表。

表 4-1. 物料清单
指示符 数量 值 说明 封装参考 器件型号 制造商

C1 1 1µF 电容，陶瓷，1µF，16V，+/-10%，X6S，0402 0402 C1005X6S1C105K050BC TDK

C2、C3 2 0.1uF 电容器，陶瓷，0.1µF，50V，+/-20%，X7R，0402 0402 GRM155R71H104ME14D MuRata

D1、D2 2 白色 LED，白色，SMD 0805 VAOL-S8WR4 Visual Communications 
Company, LLC

H1、H2、
H3、H4

4 Bumpon，半球形，0.25 X 0.075，透明 75x250mil SJ5382 3M

J1 1 端子块 6POS 侧面插入 5MM PCB HDR6 6.91138E+11 Wurth Electronics

J2 1 插座，2mm，6x2，金，R/A，TH 插座，2mm，6x2，R/A，TH NPPN062FJFN-RC Sullins Connector Solutions

J3 1 HDR12 NRPN062PARN-RC Sullins Connector Solutions

LBL1 1 热转印打印标签，0.650"（宽）x 0.200"（高）- 10,000/卷 PCB 标签，0.650 x 0.200 英寸 THT-14-423-10 Brady

R4、R7 2 10k 电阻，10k，5%，0.063W，AEC-Q200 0 级，0402 0402 CRCW040210K0JNED Vishay-Dale

R5、R6、
R8、R9

4 4.7k 电阻，4.7k，5%，0.063W，AEC-Q200 0 级，0402 0402 CRCW04024K70JNED Vishay-Dale

SW0 1 滑动开关 SP4T 表面贴装，直角 SMT_SW_11MM3_4MM1 CUS-14TB Nidec Copal Electronics（日产

科宝电子有限公司）

TP1、TP2、
TP3、TP5、
TP7、TP8、
TP10、TP11

8 测试点，微型，SMT Testpoint_Keystone_Miniature 5015 Keystone

U1 1 具有集成检测元件的 40V、16 位精密数字功率/能量/电量监控器 PowerWCSP8 INA700AYWFR/
INA701AYWFR

德州仪器 (TI)

U2 1 具有开漏输出的单路缓冲器/驱动器，DRL0005A，LARGE T&R DRL0005A SN74LVC1G07DRLR 德州仪器 (TI)
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5 其他信息

5.1 商标
Chrome® is a registered trademark of Google LLC.
Firefox ® are registered trademarks of Mozilla Foundation.
Safari® is a registered trademark of Apple Inc.
所有商标均为其各自所有者的财产。

6 相关文档

本用户指南可从 TI 网站获得，文献编号为 SBOU285。附加到文献编号的任何字母对应于撰写本文档时已有的最

新文档修订版。订购时，可通过文档标题或文献编号识别文档。表 6-1 列出了与 EVM 相关的文档。可以通过点击

表 6-1 中的链接来获取更多信息。器件名称链接至 www.ti.com 上的产品网络文件夹。文献编号链接到 PDF 文
档。

表 6-1. 相关文档

文档标题 文档文献编号

INA700 数据表 SBOSAB4

7 修订历史记录
注：以前版本的页码可能与当前版本的页码不同

Changes from Revision * (April 2023) to Revision A (July 2025) Page
• 更新了整个文档中的表格、图和交叉参考的编号格式.........................................................................................1
• 添加了入门部分.................................................................................................................................................. 1
• 将概述部分更改为简介部分................................................................................................................................ 2
• 将器件摘要表移到新的器件信息部分中.............................................................................................................. 2
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重要通知和免责声明
TI“按原样”提供技术和可靠性数据（包括数据表）、设计资源（包括参考设计）、应用或其他设计建议、网络工具、安全信息和其他资源，
不保证没有瑕疵且不做出任何明示或暗示的担保，包括但不限于对适销性、某特定用途方面的适用性或不侵犯任何第三方知识产权的暗示担
保。
这些资源可供使用 TI 产品进行设计的熟练开发人员使用。您将自行承担以下全部责任：(1) 针对您的应用选择合适的 TI 产品，(2) 设计、验
证并测试您的应用，(3) 确保您的应用满足相应标准以及任何其他功能安全、信息安全、监管或其他要求。
这些资源如有变更，恕不另行通知。TI 授权您仅可将这些资源用于研发本资源所述的 TI 产品的相关应用。 严禁以其他方式对这些资源进行
复制或展示。您无权使用任何其他 TI 知识产权或任何第三方知识产权。您应全额赔偿因在这些资源的使用中对 TI 及其代表造成的任何索
赔、损害、成本、损失和债务，TI 对此概不负责。
TI 提供的产品受 TI 的销售条款或 ti.com 上其他适用条款/TI 产品随附的其他适用条款的约束。TI 提供这些资源并不会扩展或以其他方式更改 
TI 针对 TI 产品发布的适用的担保或担保免责声明。
TI 反对并拒绝您可能提出的任何其他或不同的条款。IMPORTANT NOTICE

邮寄地址：Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
版权所有 © 2025，德州仪器 (TI) 公司

https://www.ti.com/zh-cn/legal/terms-conditions/terms-of-sale.html
https://www.ti.com
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